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1.0 Vedere de ansamblu 
 

Software-ul grafic pentru sistemele de alarmă de incendiu GUIDE permite până la 64 panouri de control Syncro să fie conectate la un 

calculator (PC) care poate afişa evenimentele în formă de text sau grafică, ca răspuns la evenimentele ce au loc în sistemul de alarmă 

de incendiu. 

 

GUIDE permite, de asemenea, ca utilizatorul să preia controlul sistemului de alarmă de incendiu prin intermediul unui panou de alarmă 

“virtual” prezentat pe ecranul calculatorului.  

 
GUIDE înregistrează toate evenimentele în sistemul de alarmă de incendiu şi permite ca aceste evenimente să fie filtrate şi prezentate 

pentru analiză într-o mare varietate de moduri. 

 
Pentru a conecta un sistem de alarmă de incendiu Syncro la un calculator ce rulează programul GUIDE, este necesară instalarea unei 

cuple într-unul dintre panourile de control şi conectarea acestuia la un port serial al calculatorului. 
Dacă sistemul de alarmă de incendiu este constituit din mai multe panouri de control, informaţiile de la celelalte panouri de control sunt 

transmise prin reţeaua sistemului de alarmă de incendiu la panoul care este conectat la PC. 
Fiecare cupla de ieşire de date este protejată de un cod de securitate, care este alocat de către Kentec Electronics Limited şi, odată 

instalat şi activat, va lucra numai pe sistemul pe care a fost instalat original. 
 

 
 
 

Sistemul GUIDE poate fi conectat la un singur panou al sistemului de alarmă de incendiu sau la o reţea de panouri de control, până la o 

distanţă de 1200 de metri de cablu corespunzător.  
Dacă calculatorul ce rulează programul GUIDE este conectat la o reţea locală (LAN), atunci sistemul GUIDE poate fi îmbunătăţit prin 

folosirea afişajelor repetoare GUIDE. Pot fi instalate până la 15 repetoare GUIDE care pot afişa şi controla sistemul de informaţii al 

reţelei de incendiu Syncro. 

 
1.1 Instalarea părţii hardware 
Partea hardware constă din două părţi, placa electronică (cardul) cuplei (număr parte S572), care se montează în panoul de control 

Syncro, Syncro Response sau Syncro AS şi convertorul RS232/RS485 (număr parte B2813), care se conectează la portul serial RS 232 

al calculatorului. 
 

NOTĂ: placa cuplei S572 nu poate fi instalată în repetoarele Syncro Focus / Focus + sau Syncro View LCD. Panoul Syncro în care 

S572 este montat trebuie să nu aibă o imprimantă de panou instalată. 
Placa cuplei furnizează o interfaţă izolată în panoul de control al incendiilor şi permite datelor din aplicaţia GUIDE să fie trimise şi 

recepţionate la panoul Syncro. Sistemul GUIDE nu poate comunica cu un panou de control de incendiu fără card şi cuplă care au codul 

de securitate activat. 
Placa cuplei este furnizată cu un cablu tip panglică (număr parte SR1012) şi clipsuri pentru a fi conectată la placa principală a panoului 

de control. Cabluri pentru conectarea la 24V auxiliar sunt montate pe card. 

 
Placa cuplei trebuie să fie conectată la alimentarea panoului de control cu panoul oprit (fără alimentare).  
Mai întâi fixaţi placa în panoul de control, apoi poziţionaţi şi conectaţi cablul panglică cu 10 fire la J5 de pe partea din faţă a panoului de 

control. Odată poziţionat, cablul panglică trebuie securizat pe poziţie cu clipsurile auto-adezive livrate. 
Conectaţi firul roşu de la placa cuplei la terminalul Aux 24V + din panoul de control. 

Conectaţi firul negru la placa cuplei la terminalul Aux 24V - din panoul de control. 

Sistem GUIDE 
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Un cablu de date cu 4 fire pentru comunicările de date RS485 ar trebui instalat de la panoul de incendiu la PC. Acest cablu de date 
trebuie conectat la terminalele marcate T+, T-, R+ şi R- de pe placa cuplei. 

 
 

 

 

 
 
 
 
1.2 Conexiunea la PC 
 

Partea hardware GUIDE include o unitate de conversie RS232 la RS485 (B2813), care permite datelor să fie transmise la distanţe mai 

mari decât cei câţiva metri cât permite conexiunea RS232. De asemenea permite izolarea între alimentarea de la PC şi cea de la panoul 

de control. Se introduce în portul serial cu 9-pini RS232 din spatele PC-ului. 

 

Conexiunea la panoul Syncro nu va funcţiona până când software-ul GUIDE nu va fi instalat şi un cod valid de securitate nu este obţinut 

de la Kentec Electronics Limited. 
 
Conectaţi cablul de date de la panoul de incendiu, după cum urmează: 
 
 
Terminalul convertorului RS232 /485   Terminalul plăcii conectorului 
 

+ XMT     R+ 
- XMT     R- 

- RCV     T- 

+ RCV     T+ 

Cablul de date la 
panoul de incendiu

Cablul de date trebuie să fie prins de convertor folosind clema şi să fie pozat astfel încât să nu apară tensiuni în acesta. 
Convertorul de date are 2 plăci electronice în interior, fiecare cu câte un micro-comutator cu 4 poziţii de tip DIL. Nu este necesar să 

schimbaţi poziţia acestor comutatoare de la setările lor din fabrică, care sunt următoarele - 

 

Cablu de date cu 4 fire 
de la convertorul 
RS232/ RS485 la PC 

Placa Syncro Placa cuplei 

Placa cuplei se montează pe 
posturile existente în panoul de 
control 

Cablul panglică cu 10 fire la conectorul J5 de pe placa de control principală 

Alimentare de 
la cuplă la 
Panoul de 
Control – Aux 

24V 

ATENŢIE! 
Nu cuplaţi şi nu decuplaţi cablul 
panglică atunci când placa este 
alimentată. Există circuite sensibile la 
electricitatea statică. Urmaţi procedurile 
de manevrare pentru componente 
sensibile la electricitatea statică, tot 

timpul! 
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Placa electronică principală     Placa electronică secundară 
 

 

 
 
 

 

Comutator 1 ON (cuplat)      Comutator 1,2 OFF (decuplat) 

Comutator 2,3,4 OFF (decuplat)     Comutator 3,4 ON (cuplat) 
 

 
Poziţia conectorilor din spatele calculatorului pot diferi de la unul la altul, dar, de obicei, există doi conectori de tip D şi modulul interfeţei  

RS232/RS485 ar trebui introdus în conectorul de 9 pini şi securizat cu şuruburile de fixare livrate. 
 

Alternativ, dacă calculatorul nu are un port serial RS232 disponibil, atunci un modul de conversie USB la RS232 trebuie folosit. Kentec 

U187 poate fi folosit pentru a livra date RS232 prin portul USB al computerului. 
 
 

1.3 Instalarea software-ului 

Cerinţe pentru PC (minim) 

Procesor - Pentium®, 600 MHz sau mai bun, dual core  

Placă grafică (video) – 32Mb sau mai bună 

Monitor – Setaţi pe rezoluţia 1024 x 768 minim 

Sistem de operare - Windows® 2000, XP sau Vista (Control panel, conturi de clienţi, selectare 

utilizator, proprietăţi, membrii de grup, selectare utilizator standard). 
 
CD Rom - CD-ROM sau unitate DVD  
 

Spaţiu pe disc - 25MB de spaţiu liber pentru instalarea simplă (20 GB recomandat dacă sunt 

folosite mai multe hărţi) 
 
Memorie - 512MB de RAM 
 

Inseraţi CD-ul în unitatea CD Rom a PC-ului şi aşteptaţi ca să înceapă instalarea. Urmaţi 

instrucţiunile de instalare şi apăsaţi “next (următorul)” la fiecare fereastră, cu excepţia faptului 

dacă doriţi să schimbaţi folderele alese de GUIDE pentru instalare din oficiu (nu este neapărat 

necesar). 
Apăsaţi “Finish (terminare)” odată ce GUIDE s-a instalat cu succes. 
 

Acum va fi un nou grup de programe (GUIDE) afişat când “All programs” este selectat din meniul de start al Windows®. 

In cadrul acestui grup sunt şase programe, un exemplu de proiect şi un program de dezinstalare care poate scoate GUIDE din sistemul 

pe care a fost instalat, dacă doriţi acest lucru. 
 
Cele patru programe principale sunt: 
GUIDE Run 
Este principalul program GUIDE. Aceasta este aplicaţia care rulează pe PC-ul conectat la panoul de control de incendiu şi care afişează 

evenimentele pentru utilizator. 
 

BMP Grabber 
Un program utilitar pentru a fi folosit cu Designer, care perimte ca formatele .dxf şi .dwg să fie convertite în formatul bitmap pentru a fi 

folosite cu programul GUIDE. 

 
Designer 
Programul Designer este folosit pentru a produce fişiere de proiect care să fie folosite cu GUIDE Run. 
Este folosit pentru a crea proiecte noi, a selecta şi edita imagini, a importa fişierele exportate din Loop Explorer, a desena zone, a plasa 

şi seta iconiţe pentru echipamente şi a seta mesaje pentru evenimente. 

 
Event Log 
Este un program utilitar care sortează evenimentele din jurnal după dată, tip eveniment, utilizator sau adresă. Aceasta permite 

interogarea jurnalului de evenimente de pe alte computere decât computerul GUIDE. 

 

Convertorul RS232/ RS485 se 
cuplează în portul cu 9 pini din 
spatele calculatorului 
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2.0 GUIDE Run 

 
2.1 Rularea programului GUIDE 
Pentru a deveni familiar cu sistemul GUIDE, încărcaţi proiectul model, rulaţi modul de simulare şi generaţi câteva evenimente. 

 

De la butonul Start din Windows®, selectaţi All Programs > GUIDE > GUIDE Run. 
Căsuţa de dialog pentru logare GUIDE – Logon va fi afişată. Daţi clic pe câmpul User Name şi apoi pe Administrator. Introduceţi Guide 
(cu caractere minuscule) ca parolă şi apoi apăsaţi Logon. 

 
Apăsaţi butonul GUIDE din partea stângă de jos a ecranului şi apoi selectaţi GUIDE Setup > Guide Settings din meniul care apare. 

Apăsaţi butonul marcat find şi apoi daţi clic pe fişierul FireX.prj. Acum apăsaţi Open. 

 
Apăsaţi OK în fereastra de informare care este afişată pe ecran şi apoi daţi clic pe Start Simulation. 

 
Proiectul exemplificativ este acum încărcat. Fereastra modului de simulare poate fi mutată din centrul ecranului prin selectarea barei 

superioare a ferestrei şi tragerea sa în poziţia dorită (partea stângă superioară a ecranului este un loc foarte bun pentru a plasa această 

demonstraţie). 
 

Partea principală a ecranului arată desenul de ansamblu al locaţiei cu două blocuri turn şi o a treia clădire mai mică. Dând clic pe oricare 

dintre cele 3 clădiri, acest lucru va mări clădirea respectivă dacă este necesar. Dând clic pe butonul “Site Map (harta)”, vă veţi întoarce 

la ecranul principal. 
 

Apăsaţi Activate de pe fereastra Event Simulator. Ecranul va arăta acum un plan al etajului 6 din Turnul de Vest şi o activare a unui 

punct de anunţare a unui incendiu. 

 
In partea stângă a ecranului există o descriere text a evenimentului şi cu o listă de evenimente dedesubtul său (în acest caz doar 

incendiul pe care l-am generat). 
 

Dezactivaţi evenimentul din ecranul Event Simulator, adăugaţi o notă corespunzătoare de descriere în fereastra de comentarii în partea 

stângă inferioară a ecranului, în care vor fi afişate toate celelalte detalii privind acest eveniment şi acceptaţi evenimentul prin apăsarea 

butonului Accept FIRE din partea de jos stângă a ecranului. 

 

Acum putem părăsi planul etajului afişat sau să ne întoarcem la harta principală prin apăsarea pe butonul Site Map din colţul stânga sus 

al ecranului. 

 

Ecranul utilizatorului are un număr de butoane de control în partea de sus. Afişarea butoanelor depinde de privilegiile de configurare ale 

utilizatorului logat pe computer. Când sunteţi logat ca administrator, toate butoanele vor fi disponibile. 
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Butonul “Site Map/ Hartă” va aduce întotdeauna afişajul la imaginea iniţială. Aceeaşi imagine va fi arătată când nu există evenimente 
active în sistem şi toate evenimentele au fost acceptate. 

 
Butonul “Zones/ Zone” va afişa o grilă, arătând starea tuturor zonelor de detecţie configurate în sistem. Când vă aflaţi în acest ecran, 

este posibil să selectaţi şi să dezafectaţi o zonă. Este de asemenea posibil să săriţi la grila “Devices/ Dispozitive” din acest ecran. 

 
Butonul “Devices/ Dispozitive” va afişa o grilă care arată starea tuturor dispozitivelor de detecţie configurate pe sistemul de incendiu. 

Când vă aflaţi în acest ecran, este posibil să selectaţi şi să dezactivaţi un dispozitiv şi să extrageţi valorile analogice ale dispozitivelor de 

detecţie. Este, de asemenea, posibil să săriţi în grila “Zones/ Zone” din acest ecran. 

 
Butonul “Event Log/ Jurnal evenimente” va lansa aplicaţia de vizualizare a jurnalului de evenimente. Aceasta va permite ca jurnalul de 

evenimente să fie afişat şi filtrat. Rezultatele căutării în jurnalul de evenimente poate fi afişat ca HTML sau ca format Listă. 
 

Butonul “Fire Panel/ Panou de incendiu” va deschide o fereastră de panou de incendiu virtual. Acesta permite Guide PC să controleze 

în mod direct panoul Syncro la care sistemul Guide este conectat, ca şi cum aţi sta în faţa panoului fizic.  
 

Butonul “Silence Computer/ Computer fără sonor” va opri alarma sonoră a unui eveniment. Pot fi rulate diverse fişiere audio pentru 

diverse evenimente sau acţiuni, folosind sistemul audio al calculatorului. Acest buton va opri orice evenimente audibile. 

 
Butonul “Send Message/ Trimite mesaj” va deschide fereastra de introducere a mesajelor. Aceasta permite persoanei logate în acest 

moment în GUIDE să afişeze automat un mesaj când programul de mesaje se deschide sub sistemul Guide. In mod curent, acest lucru 

este folosit pentru a transmite informaţiile la ceilalţi utilizatori, cum ar fi motivele pentru dezactivare. 

 
Butonul “Navigate/ Navigare” va deschide navigarea. Aceasta perimte navigarea simplă printre imagini prin folosirea butoanelor “North 

/ South / East / West / Up / Down (Nord, Sud, Est, Vest, Sus, Jos”. Acest lucru este folositor mai ales când există o întindere mare a 

etajului, evitând astfel micşorarea acestuia pentru găsirea unui alt punct de interes pe el. 

 
In partea de jos a ecranului sunt mai multe butoane de stare. Aceste butoane reprezintă fiecare tip de eveniment care poate fi afişat de 

sistemul de incendiu, cum ar fi incendii, pre-alarme, defecte şi dezactivări etc. 

Când există evenimente active în sistemul de incendiu, bara corespunzătoare de stare va fi colorată în culoarea configurată pentru acel 

eveniment şi numărul de evenimente de acel tip va fi arătat. Dând clic pe acel buton, se vor afişa mai multe detalii privind evenimentul. 

Dând clic pe eveniment, acest lucru va arăta pe harta corespunzătoare echipamentul afectat. 
 

Dacă daţi clic pe link-urile de pe hartă, puteţi mări până la imaginea de nivel de etaj. La acest nivel, iconiţele detectoarelor sunt plasate. 

Dând clic pe un detector, se deschide o fereastră cu detaliile acestuia. Folosind acest ecran, este posibil să dezactivaţi un dispozitiv, să 

verificaţi valorile analogice, să vedeţi istoricul dispozitivului şi starea sa curentă.



Man-1079_Syncro_Guide_04                     Pagina 8 din 25 

 

 

 

Dacă un link de imagine are alocată o zonă, este posibil să se dea clic dreapta pe link şi apoi să dezactivaţi şi să re-activaţi zona folosind 

acest link. 

 

Acum, că am văzut partea de bază a ceea ce poate face sistemul, putem explora setările în detaliu folosind proiectul de exemplificare. 
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2.2 Setări ale programului GUIDE   
 

Apăsaţi pe butonul GUIDE din partea stângă de jos a ecranului şi selectaţi Guide Setup şi apoi Guide Settings. Următorul ecran va fi 

afişat: 
 

 
 
2.2.1 Opţiunile tabulatorilor aplicaţiei 
 

GUIDE Design project (.prj)/ Proiect GUIDE 
Acesta este folosit pentru a selecta un fişier de proiect specific unei locaţii. Acest fişier coordonează diferitele fişiere imagine, iconiţele de 

detecţie ale dispozitivelor şi informaţii despre locaţie. Acestea trebuie să fie create la punerea în funcţiune, folosind aplicaţia GUIDE 

Designer. 
 
GUIDE Design project – Find/ Proiect GUIDE - Găsire 
Acest lucru poate fi folosit pentru a căuta şi pentru a încărca alte proiecte, pe măsură ce acestea sunt create. 
 

GUIDE Design project - PC port/ Proiect GUIDE – Port PC 
Acesta este portul COM al PC-ului folosit pentru a se conecta direct la mufa GUIDE instalată în panoul de control Syncro. Portul din oficiu 

este setat pe COM 1. Convertoarele de port USB la serial nu sunt recomandate pentru această conexiune. 
 
Event Output Directory/ Directorul de stocare evenimente 
Aceasta este locaţia unde for fi salvate jurnalele de evenimente GUIDE. Aceasta poate fi o locaţie pe discul local sau pe un server la 
distanţă, dacă este necesar.  
 
GUIDE-NET Server Project (.svr)/ Proiect server Guide-Net 
Această opţiune nu este disponibilă. 
 

Repeater Modes Remote Server Name/ Moduri repetoare nume server la distanţă 
Programul Guide poate fi pornit ca program principal (pentru calculatorul legat la panoul Syncro) sau ca un repetor la distanţă. Repetorul 

Guide trebuie să ruleze pe un workgroup sau o reţea unde computerul repetor poate accesa computerul ce rulează programul principal 

Guide. 
Această opţiune de meniu permite ca numele computerului principal Guide să fie alocat astfel încât repetorul să primească datele corecte 

pentru a le afişa şi pentru a controla sistemul de incendiu. 
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START GUIDE/NET / Pornire Guide/Net 
Aceste butoane pornesc programul GUIDE când acesta este conectat la un panou de control. Programul GUIDE nu va porni până când 

nu există o conexiune cu panoul de control şi nu au fost introduse codurile de securitate corecte. 
 

Start Simulation/ Pornire simulare 
Acest buton porneşte proiectul care este încărcat în mod curent în modul simulare şi poate fi folosit fără o conexiune la panoul de 

control, pentru testare şi demonstraţii. 

 
Start Repeater/ Pornire repetor 
Aceste butoane pornesc programul GUIDE în “Modul repetor”. Acesta este folosit când computerul este conecta la un workgroup sau 

LAN şi există un sistem Guide ce rulează pe alt calculator. Modul repetor va permite controlul complet şi raportarea către sistemul 

Syncro, dar foloseşte mai curând o conexiune LAN către sistemul principal Guide decât o conexiune directă către reţeaua Syncro. 

 
STOP GUIDE/ Oprire Guide 
Acest buton opreşte programul GUIDE din rulare şi este disponibil numai după ce GUIDE a pornit cu succes. 
 

Synchronise time/ Sincronizare oră 
Ora setată pe PC poate fi trimisă către panoul la care este conectat acesta (şi toate panourile de incendiu dacă acestea sunt în reţea). 
 
 
2.2.2 Behaviour tab/ Tabulatorul de comportare 
Zona principală a acestui tabulator este folosită pentru a selecta cum răspunde programul GUIDE la fiecare tip de eveniment disponibil. 
 

IMPORTANT – Panoul Syncro la care este conectat sistemul Guide trebuie să fie configurat în modul Loop Explorer pentru a 

afişa toate evenimentele de la celelalte panouri, într-o reţea (network master) ŞI trebuie să fie configurat cu o opţiune 

“Graphics Fitted” selectată din setările panoului. Panoul Syncro nu trebuie să aibă instalată o imprimantă. 
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Processes/ Procese 
Dacă această căsuţă nu este bifată, aceste tipuri de evenimente nu vor fi afişate, dar vor fi înregistrate în jurnal, tipărite şi trimise prin e-
mail. 

 
Logged to File/ Înscriere în fişierul jurnal 
Dacă această căsuţă nu este bifată, aceste evenimente nu vor fi înregistrate în jurnalul de pe computer. 
 

Force Acceptance/ acceptare forţată 
Dacă această căsuţă nu este bifată şi un eveniment este şters (prin resetarea panoului de control, de exemplu) sa va şterge automat 

afişarea text din partea stângă a ecranului şi nu va trebui să fie acceptat. 
 
Prints/ Tipărire 
Dacă această căsuţă este bifată, evenimentele de acest tip vor fi tipărite pe imprimanta setată pe sistemul Windows conectată la 
calculator sau la reţeaua LAN. 

 
Emails/ e-mailuri 
Dacă această căsuţă este bifată, evenimentele vor genera un e-mail care să fie trimis către destinatarii selectaţi (vedeţi tabulatorul 

Graphics/Events pentru detalii). 

 
Nodes to ignore/ Noduri de ignorat 
In sistemele de reţele, care pot acoperi diferite clădiri cu centre de securitate diferite, poate fi avantajos să se selecteze toate 

evenimentele de la mai multe panouri (noduri) să fie ignorate. Nodurile care trebuie ignorate trebuie să fie introduse cu virgula între ele, 

de ex. 1,2,4. 

 
Zones to Ignore/ Zone de ignorat 
La fel, poate fi benefic să se ignore evenimentele din anumite zone de detecţie. Zonele de ignorat trebuie introduse cu virgule între ele. 

 
Archive Event Log File/ Fişier jurnal pentru eveniment de arhivă 
Înregistrarea evenimentelor în jurnal este făcută într-un număr de fişiere care sunt create la intervale regulate. Frecvenţa de creare a 

unui nou fişier este selectată folosind această opţiune. Această facilitate permite ca o parte din evenimentele înregistrate să fie arhivate, 

prin eliminarea numai a fişierelor mai vechi folosite la crearea completă a jurnalului. 
 

Analogue Value Charting/ Cartografierea valorilor analogice 
Această facilitate în versiune beta permite tuturor valorilor analogice ale tuturor detectorilor să fie înregistrate  şi salvate la intervale 

regulate, pentru interogări ulterioare. 
 

Printing Options/ Opţiuni de tipărire 
Când a fost selectată opţiunea “Print” pentru un eveniment, atunci este posibil să selectaţi dacă va fi tipărit ecranul în forma sa sau o 

informaţie de tip text. Există de asemenea facilitatea de a adăuga text specific în partea de jos a foii tipărite, de exemplu instrucţiuni de 

completare sau proceduri pentru locaţie. 

2.2.3 Graphics/Events tab – Tabulatorul grafice/evenimente 

2.3.3.1 Tabulatorul pentru ecran 

Map Background colour/ Culoare fundal hartă 
Permite culorii fundalului ecranului principal să fie aleasă dintr-o paletă de culori comune sau să fie selectată automat după culoarea din 

colţul imaginii hărţii. Culoarea fundalului este vizibilă doar dacă imaginea nu umple complet ecranul. 
 

Show Device Address Labels/ Arată etichetele de adresare ale dispozitivelor 
Afişează permanent eticheta cu informaţiile despre adresa a tuturor dispozitivelor de detecţie vizibile pe harta selectată. Dacă aceasta 

nu este selectată, informaţiile despre dispozitive sunt afişate doar în momentul în care cursorul este deasupra unei iconiţe a 

dispozitivului. 

 
Map Navigation Border Buttons/ Butoane marginale de navigare pe hartă 
Dacă configuraţia locaţiei a fost făcută folosind navigaţia dintr-o imagine într-alta, decât folosind butonul “Navigate” pentru a deschide 

partea de navigare, este posibil să daţi clic pe marginea hărţii pentru a vă muta în imaginea următoare. 

De aceea, dacă daţi clic pe marginea din stânga a imaginii, aceasta va trece la imaginea următoare, situată în partea de vest a celei 

curente, dacă această opţiune este activă. 

 
Navigation Transition Effects/ Efecte de tranziţie la navigare 
Selectând această opţiune, se permite o tranziţie mai fină între imaginile hărţilor când se navighează între imagini pe calculatoarele mai 

vechi şi mai lente. Pe calculatoarele moderne, tranziţia este suficient de rapidă, încât este invizibilă. 
 

System Status in Map Windows/ Starea sistemului în ferestrele hărţii 
Când această opţiune este selectată, va arăta mesajele de înaltă prioritate pe ecranul hărţii principale. In particular, mesajul "System 

Offline" devine foarte pregnant când este selectată această opţiune. 

 
Event Pane Layout/ Aşezarea panoului de evenimente 
Panoul de evenimente este normal selectat în partea stângă a ecranului. Totuşi, este posibil să se ajusteze locaţia panoului de 

evenimente în partea dreaptă sau partea de jos a ecranului calculatorului, dacă se doreşte acest lucru. 
 

Mouse only / Touch screen – Numai mouse/ ecran cu atingere 
Când e selectată această opţiune, sistemul Guide va suporta o opţiune de ecran cu atingere. In acest mod, iconiţa tastaturii virtuale este 

prezentă în momentul logării în sistemul Guide şi atunci când se acceptă evenimente, eliminând în acest fel necesitatea unei tastaturi 

convenţionale pentru scrierea de mesaje. 
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Map Auto Scroll Time/ Timp de auto-deplasare al hărţii 
Dacă mai mult de un eveniment este prezent şi evenimentele se află pe hărţi diferite, programul GUIDE poate fi configurat să se 

deplaseze între toate hărţile active. Aceste setări permit ca timpul de auto-deplasare al hărţii să fie setat între 5 secunde şi 1 minut sau 

să fie oprit complet. 

 
Event Action Settings / Setări acţiuni evenimente (Arătate pentru toate opţiunile tabulatorilor) 
Pentru fiecare tip de eveniment, diferite efecte grafice pot fi atribuite, folosind următoarele setări: 
 
Animation Speed/ Viteză de animaţie 
Când sunt folosite iconiţe cu animaţie, viteza de animaţie a acestora poate fi selectată (slow/ încet, normal sau fast/ rapid) 
 
Colour schemes/ Scheme de culori 
Schemele selectabile schimbă culorile şi animaţiile fiecărui tip de eveniment, în mod global. 

 
Global event colour/ Culoare eveniment global 
Culoarea animaţiei ce înconjoară un dispozitiv activat poate fi schimbată. 

 
Event animation/ Animaţie eveniment 
Efectul de animaţie ce înconjoară un dispozitiv activat, poate fi schimbat. 

 
Active Appearance/ Apariţie activare 
Iconiţa activată poate fi selectată să fie animată, să clipească sau să aibă o iluminare statică. 

 
Event Icon in Flashing Links/ Iconiţe de eveniment în legături care clipesc 
Această opţiune va arăta iconiţa de tip de eveniment în imaginile de nivel superior, care au legături numai în harta unde evenimentul s-a 

produs. Aceste legături, de asemenea, vor fi subliniate în culoarea evenimentului.  
 
Auto Stop Flash/ Oprire automată clipire 
Această opţiune va opri automat clipirea iconiţelor detectoarelor când un eveniment a fost acceptat. 
 

Event actions/ Acţiuni eveniment 
Aceasta permite ca una sau mai multe adrese de e-mail şi corpuri de mesaje text să fie adăugate, pentru ca evenimentele care sunt 

selectate să trimită e-mailuri din tabulatorul de comportare să le trimită către destinatarii doriţi. 
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2.3.3.2 Events Action Tab/ Tabulatorul de acţiuni evenimente 
 
 

 

On New Event/ In cazul unui eveniment nou 
Aici este posibil să selectaţi dacă panoul de evenimente este afişat automat când un eveniment are loc. Există de asemenea o opţiune 

pentru a sublinia noile evenimente prin intermediul unor linii subţiri când acestea au loc. 

 
Change Current Map / Schimbarea hărţii curente 
Când intervine un nou eveniment, sunt câteva opţiuni pentru a determina răspunsul sistemului Guide. Alegerile sunt să se facă o mărire 

pe dispozitiv, să se facă o mărire pe harta pe care s-a produs evenimentul, să se păstreze imaginea curentă sau să se revină la 

imaginea principală a zonei. 
 

Map Device Arrows/ Săgeţi pentru hartă 
 

Arrow from event to Device/ Săgeată de la eveniment la dispozitiv 
Când este selectat un dispozitiv în panoul de evenimente, o săgeată este generată automat pentru a arăta dispozitivul selectat. 
 

Arrow from Device Window to Device/ Săgeată de la fereastra cu dispozitive la dispozitiv 
Când s-a dat clic pe o iconiţă a unui dispozitiv, ecranul de detalii al dispozitivului este afişat, aşa cum este prezentat în secţiunea 2.1. 

Dacă selectaţi această căsuţă, atunci o săgeată va fi arătată de la ecranul cu detaliile dispozitivului la iconiţa selectată. 

 
On Dongle Disconnect/ La deconectarea mufei 
Aceasta permite sistemului să încerce să se reconecteze la mufă la fiecare 5 secunde când este selectat (se recomandă selectarea). 
 
Stop Flash Link on Accept/ Oprire clipire legătură la acceptare 
Când acest lucru este selectat, legăturile către evenimentul activ nu vor mai clipi când evenimentul a fost acceptat  
 
 
2.3.3.3 Event Grid/Thumbnails Tab – Tabulatorul cu grila de evenimente/ iconiţe 

 
 

 

Grid Columns/ Coloane grilă 
Această opţiune permite utilizatorului să configureze ce informaţie este arătată în panoul de vizualizare a imaginilor. Trei dintre opţiuni 

pot fi selectate/ deselectate. A patra coloană (coloana cu timpii evenimentelor) poate fi configurată ca fiind ascunsă, ca oră a producerii 

evenimentului sau ca durată de când s-a produs evenimentul. 
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Event pane width/ Lăţimea panoului de evenimente 
Este posibil să se configureze lăţimea panoului de evenimente. Aceasta este necesară ocazional, când sunt folosite caractere mari sau 

dacă sunt configurate rezoluţii de ecran mai mici decât cea recomandată. Puteţi face aceasta prin selectarea manuală şi tragerea de 

marginea ferestrei de evenimente la lăţimea dorită.  

Butonul de Reset al panoului de evenimente readuce fereastra la lăţimea sa iniţială. 
 

Event Timer Column/ Coloana timpilor evenimentului 
Aceasta permite celei de-a patra coloane a panoului de evenimente să fie configurată. Această coloană poate fi configurată să nu arate 

nimic sau să arate ora la care a survenit evenimentul sau cât timp a trecut de la producerea evenimentului. Ultima este utilă în sistemele 

care utilizează întârzieri ale ieşirii, pentru că arată cât de mult timp a trecut de când evenimentul s-a produs şi cât timp a mai rămas. 
 

Thumbnails/ Iconiţe 
Această opţiune permite crearea unei iconiţe pentru fiecare hartă din proiect pentru a fi afişată într-o coloană în partea dreaptă a 

ecranului. Aceste iconiţe pot fi folosite pentru a naviga mai uşor în alte hărţi, dacă este necesar. Dacă este selectată această opţiune, 

sistemul Guide va trebui să fie re-pornit înainte ca schimbările să fie afişate. 

 
Show Gridlines/ Arată liniile grilei 
Această facilitate permite afişarea liniilor grilei între coloane, în modul panoului de vizualizare a evenimentelor. 

 
Show Fire Event List/ Arată lista incendiilor 
Această opţiune va aloca o secţiune separată în panoul de evenimente, deasupra afişării informaţiilor curente, unde vor fi afişate numai 

evenimentele de INCENDIU. Acest lucru este în particular folositor în instalaţii unde pot exista dezactivări active multiple, deoarece 

evenimentele de incendiu vor fi vizibile imediat. 
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2.3.3.4 Event Grid/Thumbnails Tab - Tabulatorul grilei de evenimente/ iconiţe 
 
 

 

 

Function One / Function Two – Funcţia unu/ Funcţia doi 
Aici este posibil să se aloce textul pentru cele două butoane de funcţii din ecranul panoului Virtual Syncro (accesat de către butonul 

“Panoul de incendiu” din partea superioară a ecranului Guide. Acest lucru este folositor în mod particular dacă acestea au fost 

configurate pentru o funcţie specifică, cum ar fi “Evacuate/ Evacuare” sau “Performance Mode/ Mod de realizare”, de exemplu. 
 
2.2.4 Audio tab/ Tabulator audio 
Acesta permite ca diferite sunete să fie adăugate pentru fiecare tip de eveniment. Sunetul selectat poate fi emis o dată sau în mod 

repetat, până când  evenimentul este acceptat.  O sursă utilă de sunete poate fi găsită în Windows® în folderul C:\WINDOWS\Media. 
Alte sunete pot fi, de asemenea, utilizate, inclusiv voce. Mesajele vocale de până la 60 secunde lungime pot fi înregistrate folosind  

Windows® sound recorder. 
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Fiecare tip de eveniment poate fi, de asemenea, anunţat, folosind fie fişierul audio wav selectat fie voce sintetizată. Dacă se cere ca 
mesajul să fie voce, scrieţi mesajul în fereastra “Speech”. 
Pot fi alocate diferite fişiere audio sau mesaje vocale pentru diferite tipuri de evenimente. Aceasta permite prioritizarea evenimentelor, 

cum ar fi de exemplu culoarea pentru incendiu să fie uşor identificabilă şi audibilă şi să atragă atenţia utilizatorului când intervine un 

astfel de eveniment. 

 
Test Output/ Testare 
Aceasta permite testarea sunetului sau mesajului selectat. Dacă a fost bifată opţiunea "repeat until accepted/ repetare până la 

acceptare", atunci este posibil să opriţi testul folosind butonul din dreapta. 
 
Volume/ Volum 
Volumul fişierului audio poate fi ajustat de această setare de pre-configurare. 

 
Upon Event Occurring/ La apariţia unui eveniment 
Permite fişierului audio sau mesajului să fie repetat (până la confirmare folosind butonul din partea superioară a ecranului), sau să fie 

rulat doar o dată. In mod curent, setarea este de repetare până la confirmare.  
 

Auto Speak/ Auto mesaj 
Opţiuni de configurare pentru a permite sintetizatorului vocal să citească orice mesaje din program pe măsură ce acestea se produc 

sau să citească orice sugestii când un lucru particular este subliniat. 

 
2.2.5 Status Panels tab/ Tabulator panou stare 
 

 
 
  

 

Panourile de stare sunt “butoanele de informaţii” care se văd în partea de jos a ecranului de operare normală. In circumstanţe normale, 

aceste butoane arată numărul evenimentelor active pentru fiecare tip de eveniment. 

Este posibil să se programeze aceste butoane să arate starea unei zone particulare a sistemului de detecţie a incendiului. Acest lucru 

poate fi folositor în instalaţii unde există un risc mare sau este o zonă sensibilă. 

  
Flash Status Panels When Active/ Clipirea panourilor de stare când sunt active 
Când această opţiune este selectată, panourile de stare din partea de jos a ecranului vor clipi în culoarea corespunzătoare configurată 

pentru tipul evenimentului.  
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2.2.6 Quiet Message tab/ Tabulator oprire mesaj audio 
Un mesaj poate fi adăugat şi afişat în partea superioară a panoului lateral. Acesta va apărea numai când sistemul GUIDE este conectat 

la un panou de control şi rulează 

 
2.2.7 About tab/ Tabulator “despre” 
Acesta va arăta versiunea software-ului GUIDE Run şi informaţii adiţionale despre computer. 

 
2.3 User Setup/ Setări utilizator 
 

 

 

 

Odată ce sistemul este configurat şi instalat, poate fi de dorit să se restricţioneze anumite funcţii, în aşa fel încât utilizatorii finali să nu 

poată schimba setările care ar putea împiedica sistemul să prezinte informaţiile dorite. 

 

Daţi clic pe butonul GUIDE în partea inferioară stângă a ecranului şi selectaţi User Setup/ Setare utilizator, al doilea item de sus al 

meniului ce apare. Alternativ, daţi clic pe "User Setup" care apare în colţul din partea stângă de jos în oricare dintre ecranele de setare 

ale programului Guide, după cum se arată mai sus. 

 

La prima instalare, va fi alocat doar un utilizator. Acesta va fi contul de Administrator, cu parola de logare din oficiu “GUIDE”. Acest cont 

poate fi editat, dar nu poate fi şters. Cel puţin un cont de administrator este necesar, dar pot fi generate mai multe conturi de 

administrator dacă este nevoie. Pot fi generate până la 12 conturi diferite. 

 
Add User/ Adăugare utilizator 
Dând clic pe butonul Add User, se deschide un formular de setare. 
 

User Name/ Nume utilizator 
Introduceţi numele utilizatorului sau un nume comun, de exemplu “Paznic” in acest spaţiu. Acest nume va fi vizibil pe ecranul de logare 

atunci când programul Guide este pornit. 

 
Password/ Parola 
Introduceţi parola utilizatorului specific în acest spaţiu şi scrieţi-o din nou pentru a o confirma. 
 
Test/View Password – Testare/Vizualizare parolă 
Aceasta permite vizualizarea parolelor configurate anterior. 

 
Automatically log in use off after…/ De-logaţi automat utilizatorul după.... 
Când este selectată această opţiune, utilizatorul va fi de-logat după o perioadă de timp predefinită de inactivitate. Aceasta asigură faptul 

că numai utilizatorul corect este logat la sistem şi sistemul este în stare securizată când nu există utilizatori prezenţi. 
 

Administrative Privileges/ Privilegii administrative 
Când este selectată această opţiune, utilizatorul are privilegii administrative complete, inclusiv abilitatea de a închide aplicaţia şi de a 

configura utilizatorii şi opţiunile. Această opţiune ar trebui să fie valabilă numai pentru personalul şcolarizat al conducerii. 
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Start GUIDE Service On User Login / Pornire serviciu GUIDE la logarea utilizatorului 
In eventualitatea unei re-porniri a calculatorului, când această opţiune este selectată, legătura la sistemul de detecţie va fi stabilită în 

momentul în care utilizatorul se loghează în sistemul Guide. Acest lucru evită prezenţa unui administrator pentru a porni serviciul 

GUIDE. Este recomandat ca această opţiune să fie selectată pentru toţi utilizatorii. 
Când folosiţi programul de configurare Guide în mod de simulare, poate fi preferabil să dezactivaţi această opţiune pentru a preveni 

sistemul Guide să încerce să se conecteze la panoul de control Syncro. 
 

 
 

Standard controls/ Controale standard 
De-selectarea acestor opţiuni plasează restricţii pentru elementele disponibile. Când sunt deselectate, funcţiile corespunzătoare sunt 

scoase din programul Guide run, mai curând decât să fie "scrise cu gri". 
Opţiunea "Allow application minimise/ permitere minimizare aplicaţie” ar trebui să fie deselectată în cele mai multe cazuri, deoarece 

acest lucru permite aplicaţiei să fie minimizate şi alte programe din Windows să ruleze. Recomandarea de utilizare a programului Guide 

este de a fi singurul program care rulează pe computere dedicate . 
 

Device Name/ Numele dispozitivului 
Intr-o cameră unde rulează ecranul “Devices/ Dispozitive” există o opţiune pentru a arăta nume simple ale dispozitivelor, cum ar fi 

detectoare de fum, detectoare de căldură etc, sau de a arăta nume descriptive, cum ar fi detector de fum fotoelectric, detector de fum cu 

ionizare.  
Ultima include şi numărul de referinţă al producătorului şi este propice pentru utilizatorii care sunt familiarizaţi cu astfel de dispozitive.  
Sistemul Guide va trebui să fie repornit pentru ca schimbările să apară.  
 

Edit User/ Editare utilizator 
Acest buton permite facilitatea de a folosi detalii ce pot fi amendate. Opţiunile globale sunt identice pentru cei ce folosesc opţiunea “New 

User/ Utilizator nou” de mai sus. 

 
Remove User/ Ştergere utilizator 
Permite ştergerea conturilor de utilizator. Trebuie să existe cel puţin un cont de administrator. 
 
2.4 Cod de securitate 
Pentru ca programul Guide să comunice cu panoul de control Syncro, este necesar să se introducă codul de deblocare Guide. 
 

Înainte de a începe 
Veţi avea nevoie de comanda de achiziţie şi detaliile companiei dumneavoastră înainte de a contacta departamentul de vânzări Kentec 

pentru codul de deblocare. 
 

Cererea unui cod de deblocare 
Apăsaţi butonul GUIDE din partea stângă de jos a ecranului şi selectaţi opţiunea “Security Code”, pentru a vedea instalatorul de cod de 

securitate 
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Read Dongle Code/ Citeşte codul cuplei 
Dacă există deja un cod de securitate în sistemul Guide, atunci detaliile numărului de panouri deblocate, codul comenzii de achiziţie şi 

numărul de referinţă al clientului vor fi afişate în fereastra de mai sus. Apăsaţi pe Read dongle code pentru a re-împrospăta această 

informaţie. 
 

Get New Dongle Code/ Obţinerea unui nou cod 
1) Dacă codul este nou (de ex. nu a mai fost programat înainte) daţi clic pe butonul Get New Dongle Code. 

2) Partea hardware va fi interogată şi un număr de cod va fi afişat. Notaţi acest număr de cod. 

3) Trimiteţi acest număr departamentului vânzări al Kentec Electronics Limited, împreună cu detaliile companiei dumneavoastră şi 

comanda de achiziţie cu care a fost cumpărat produsul. Acestea pot fi trimise prin e-mail (sales@kentec.co.uk), prin fax sau prin telefon. 

Notă: Numărul poate fi copiat pe clipboard, şi astfel poate fi tipărit folosind un editor de text sau trimis pe e-mail direct la Kentec 

Electronics Ltd. 
4) Departamentul de vânzări al Kentec va folosi acest cod livrat şi informaţiile de pe comanda de achiziţie pentru a genera un cod unic 

de deblocare, care poate fi transmis prin telefon sau e-mail. 

 
Authorise Code/ Autorizare cod 
Când codul de deblocare a fost trimis de către Kentec, daţi clic pe butonul “Authorise Code” şi urmaţi informaţiile de pe ecran pentru a 

introduce noul cod de deblocare. 
Apăsaţi Authorise şi atunci cupla va fi autorizată (pentru a fi folosită numai în această instalaţie). 
 
 
2.5 Serviciu GUIDE 
 

Daţi clic pe butonul GUIDE în partea stângă de jos a ecranului şi selectaţi User Setup, al patrulea item de sus al meniului care apare. 

Trei opţiuni adiţionale sunt prezentate: 

 
Start GUIDE Service/ Pornire Serviciu Guide 
Acesta va porni serviciul GUIDE in mod de rulare normal, dar numai când este corect conectat la un panou de control şi cu codul pentru 

cuplă activat. Pornirea serviciului GUIDE când acesta nu este conectat la un panou de control sau cu un cod incorect pentru cuplă, va 

rezulta într-un mesaj de eroare. 

 
Start Simulation Mode/ Pornire mod simulare 
Acesta va porni sistemul GUIDE in modul de simulare, după cum este descris în secţiunea anterioară 2.1 Rularea programului GUIDE. 
 
Stop Active Service Mode/ Oprirea modului de serviciu activ 
Acesta va opri un serviciu GUIDE ce funcţionează. 
 
 
2.6 Vizualizare hărţi 
Daţi clic pe butonul GUIDE din partea inferioară stângă a ecranului; selectaţi opţiunea“Screen/ Ecran”, şi apoi View Maps. 
Aceasta va arăta lista de hărţi care sunt încărcate în proiectul deschis. Dând clic pe iconiţa unei hărţi, va afişa harta pe ecranul principal. 

 

mailto:sales@kentec.co.uk
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2.7 Vizualizarea dispozitivelor în buclă 
(disponibile de asemenea prin butonul “Devices”  din partea superioară a ecranului principal) 
 

Daţi clic pe butonul GUIDE din partea stângă inferioară a ecranului; selectaţi opţiunea “Screen/ Ecran”, şi apoi selectaţi View Loop 

Devices/ Vizualizare dispozitive în buclă. 
 
Toate dispozitivele din proiectul curent pot fi vizualizate într-o fereastră care poate fi modificată ca mărime, în format tabel, după cum 
urmează: 
 

Iconiţa dispozitivului 

Tipul dispozitivului 

Nodul (panoul la care este conectat dispozitivul) 

Bucla 

Adresa 

Zona 

Textul de localizare 

Starea (normală/ activă) 

Dezactivat (cu căsuţa de dezactivare bifată dacă GUIDE rulează) 
Baza alarmei instalată 

Valoarea analogică a dispozitivului (dacă GUIDE rulează) 
Hărţile pe care dispozitivul este localizat 

Există de asemenea un buton în această fereastră pentru a vedea starea fiecărei zone, arătând numărul de evenimente active de 

fiecare tip şi opţiunile de dezactivare a zonelor sau punerea lor în modul de testare. 

Mai este furnizat un buton pentru reîmprospătarea informaţiilor analogice. 

 
2.8 Vizualizare zone 
(disponibile de asemenea prin butonul “Zones”  din partea superioară a ecranului principal) 
Daţi clic pe butonul GUIDE din partea stângă inferioară a ecranului; selectaţi opţiunea “Screen/ Ecran”, apoi View Loop 

Devices/ Vizualizare dispozitive în buclă. 
Starea fiecărei zone este afişată sub formă de tabel. Toate zonele, cu excepţia zonei 0, pot fi dezactivate. 

 
2.9 Tipărirea evenimentului curent 
Daţi clic pe butonul GUIDE din partea stângă inferioară a ecranului; selectaţi opţiunea “Events/ Evenimente” şi apoi “Print Current 

Event/ Tipărirea evenimentului curent”. 
Prin selectarea opţiunii Print Current Event, un eveniment activ poate fi tipărit pe imprimanta instalată. Pentru a tipări alte evenimente 

active, selectaţi-le şi apoi selectaţi Print Current Event din nou. 
 
2.10 Jurnal evenimente 
(disponibil de asemenea prin butonul “Event log”  din partea superioară a ecranului principal) 
Daţi clic pe butonul GUIDE din partea stângă inferioară a ecranului; selectaţi opţiunea “Events/ Evenimente” şi apoi “Event Log/ Jurnal 

evenimente”. 
 
Jurnalul de evenimente este afişat în format HTML într-o fereastră ce poate fi redimensionată. Jurnalul de evenimente poate fi schimbat 

într-o vedere tip text listă, salvat pe disc, tipărit sau trimis pe e-mail prin butoanele din partea superioară a acestei ferestre.  
Prin selectarea butonului New Search/ Căutare nouă, jurnalul de evenimente poate fi sortat pe tip evenimente, utilizator, dată, nod, 

buclă, zonă, adresă sau tip dispozitiv sau orice combinaţie a acestora. Acest filtru puternic ajută la producerea datelor care pot fi 

analizate, pentru urmărirea activărilor repetate şi este o sculă puternică de luptă împotriva alarmelor false.  

 
2.11 Aranjare ferestre 

Daţi clic pe butonul GUIDE din partea stângă inferioară a ecranului; selectaţi “Screen/ Ecran” şi apoi “Map Windows/ Aranjare ferestre”. 

Sunt prezentate trei opţiuni adiţionale: 

Tile Horizontally/ Dispunere orizontală 
Afişează toate hărţile active de pe ecran pe orizontală. 
 

Tile Vertically/ Dispunere verticală 
Afişează toate hărţile active de pe ecran pe verticală. 
 

Cascade 
Afişează toate hărţile active de pe ecran pe una peste cealaltă. 
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2.12 Minimizare (pentru a folosi Microsoft Windows) 
Daţi clic pe butonul GUIDE din partea stângă inferioară a ecranului; selectaţi “Screen/ Ecran” şi apoi “Minimise Guide/ minimizaţi Guide”. 
Aceasta permite aplicaţiei GUIDE să se micşoreze sub forma unei bare mici gri în partea stângă de jos a ecranului, astfel încât alte 

aplicaţii Windows® să poată fi folosite în timp ce GUIDE încă rulează. 
O opţiune pentru a continua să arate un sumar al evenimentelor este de asemenea posibilă cu această opţiune (Minimise Guide cu Tray 

Status) 
Pentru a re-aduce GUIDE ca fereastră principală, daţi dublu clic pe această bară gri. 

 
2.13 De-logare Administrator 
(disponibile de asemenea prin butonul “Log off”  din partea inferioară dreaptă a ecranului principal) 
 
Daţi clic pe butonul GUIDE din partea stângă inferioară a ecranului şi selectaţi “Log Off Administrator”. 
Acest lucru va de-loga administratorul şi va prezenta fereastra de logare GUIDE pentru a permite utilizatorilor să se logheze. 

 
2.14 Închidere GUIDE 
Daţi clic pe butonul GUIDE din partea stângă inferioară a ecranului şi selectaţi Shutdown GUIDE din partea de jos a meniului ce apare. 
Acest lucru va opri aplicaţia GUIDE. 

 
2.16 Bară laterală (Panou evenimente) 
Pentru a suplimenta informaţia afişată prin intermediul hărţilor, diagramelor şi fotografiilor, o bară laterală apare atunci când un 

eveniment este activat. 
Partea superioară a barei laterale arată tipul de eveniment şi informaţiile, aşa cum au fost ele concepute în programul Designer. 

Numărul nodului (sau dacă panoul a fost programat cu un nume de panou, numele panoului va fi afişat). 

Număr zonă (şi textul de zonă, dacă a fost adăugat în programul Designer). 

Numărul de adresă şi numărul buclei 

Tipul dispozitivului 

Textul specific care a fost adăugat în programul Designer. 

Mai jos de fereastra cu text există o fereastră de stare unde o listă cu toate evenimentele active este afişată. Aceasta poate fi acceptată 

individual prin selectarea evenimentului şi apăsarea tastei Accept. 

 
 
 
3.0 Proiectare (Designer) 
 

Înainte ca un proiect GUIDE să poată fi creat, ar trebui să aveţi un fişier de tip Loop Explorer “.lx2” şi câteva hărţi în format Bitmap/ 

JPEG / TIFF / GIF / WMF într-o locaţie convenientă, astfel încât acestea să poată fi importate. 
 
Loop Explorer este utilitarul de configurare a panoului de control folosit pentru a configura panourile de incendiu Syncro. 
Un fişier de tip .lx2 poate fi creat din Loop Explorer prin selectarea “Export Loop Explorer config.” din meniul “File” şi salvarea sa într-o 

locaţie convenientă. 
 

Din motive de exersare, fişierele din proiectul de exemplificare situate în c:\program files\GUIDE\example project pot fi folosite. 
Aici veţi găsi un fişier .lx2 numit  FireX.lx2 şi un număr de imagini de hărţi. 
 

Pentru a porni programul de proiectare, daţi clic pe butonul START din Windows – Programs - GUIDE  şi apoi Designer. 
Apăsaţi “Start New GUIDE Project”, şi apoi “OK”, apoi introduceţi un nume de proiect şi salvaţi proiectul într-o locaţie unde va putea fi 

găsit cu uşurinţă mai târziu. 
 

Când apare programul de importare a hărţilor, după salvarea proiectului, selectaţi Next, şi apoi selectaţi hărţile pe care doriţi să le 

importaţi în proiect (hărţile din c:\program files\GUIDE\example project pot fi folosite în scopuri de exemplificare) şi apoi daţi clic pe  

next din nou. 
 

Aici puteţi denumi fiecare hartă cu un nume diferit de cel original dacă este nevoie şi să selectaţi una dintre hărţi să fie harta principală a 

locaţiei. 

 

Harta principală a locaţiei va fi afişată pe ecran tot timpul cât GUIDE rulează şi nu există alte evenimente care să solicite alte hărţi.  
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Daţi clic pe next şi apoi selectaţi fişierul Loop Explorer .lx2 pe care doriţi să-l folosiţi pentru acest proiect. (fişierul .lx2 din fişierele date 

poate fi folosit în scopuri de exemplificare dacă este nevoie). 

 
Apăsaţi next şi apoi ecranul principal de proiectare va fi afişat, arătând harta principală cu un navigator de proiect şi un navigator de 

reţea în partea stângă . 

 
Fiecare dintre hărţi poate fi acum vizualizată prin selectarea acestora din fereastra navigatorului de proiect din partea stângă a ecranului 

şi dispozitivele de alarmă de incendiu care au fost importate din fişierul  .lex pot fi văzute prin expandarea iconiţei panoului de control în 

fereastra navigatorului de reţea de sub fereastra navigatorului de proiect. 
Bara verticală este pentru a re-dimensiona zonele (primele 8 unelte) şi aranjarea iconiţelor (ultimele 4 unelte). 

 
 
3.1 Alocarea zonelor şi legături pe hartă 
 
Înainte de a putea plasa orice tip de dispozitiv, trebuie adăugate zone pe hartă. 
Selectaţi o hartă din navigatorul de proiect, care este cea mai detaliată. (Cea care va arăta detectoarele activate, punctele de alarmă, 

etc.)  

 

Când harta este afişată, prin clic dreapta se va afişa un meniu din care pot fi selectate opţiunile pentru harta din fundal. 

 

Din tabulatorul Map Details, numele hărţii poate fi schimbat, o altă hartă poate fi selectată; harta poate fi arătată ca imagine negativă 

sau în tonuri de gri sau harta poate fi editată prin selectarea Edit Picture. Acest lucru va încărca GUIDE Draw, în funcţie de tipul de fişier 

– un program simplu de desenare, altfel va încărca Windows Paint. (Select File> Exit pentru a ieşi din editorul de imagini). 
 

Tabulatorul Map Size/ Dimensiunea hărţii permite hărţii să fie redimensionată pentru cea mai bună potrivire pe ecran. Selectând căsuţa 

Lock, harta îşi va păstra proporţiile la redimensionare. 
 

Tabulatorul de mărime a grilei permite ca aceasta să fie afişată cu un spaţiu între linii de la 4 la 80 de pixeli prin ajustarea cu ajutorul 

butonului de spaţiere. 

 

Opţiunea Snap to Grid oferă facilitatea de a avea zonele desenate puse pe această grilă. 
 

Distanţa dintre iconiţe poate fi de asemenea setată, între 1 şi 50 de pixeli folosind butonul de spaţiere. 

Această distanţă reprezintă distanţa cu care se va mişca o iconiţă când se folosesc ustensilele de pe bara ce se deplasează vertical pe 

ecran. 
 

Odată ce opţiunile privind hărţile au fost setate, daţi clic pe New Link/Zone – Legătură/zonă nouă din bara de meniu din partea 

superioară a ecranului. Cursorul se va schimba într-o săgeată multi-direcţională cu un „Z‟ în dreptul său dacă este o zonă, sau, altfel, va 

fi o legătură „Link‟. 

 

Daţi clic pe hartă unde trebuie desenată zona. Aceasta va afişa opţiunile editorului pentru zone ce pot fi selectate. 

 

 
3.2 Desenarea şi legarea zonelor 
 
Legături pe hartă 
Legăturile pe hartă sunt folosite pentru a permite mărirea sau micşorarea pentru a arăta mai multe sau mai puţine detalii. De exemplu, 

GUIDE poate monitoriza un număr de clădiri într-o locaţie foarte mare, cum ar fi un complex spitalicesc.  

 
In acest caz, harta principală va fi o hartă ideală ce va arăta toată locaţia, incluzând clădirile individuale care sunt monitorizate. 

 

Fiecare dintre aceste clădiri poate avea o legătură pe harta principală care, atunci când este accesată, va dispune un plan complet al 

acelei clădiri. Este posibil ca, clădirea să fie prea mare pentru a putea arăta detaliile necesare într-o situaţie de incendiu şi atunci, 

legături către planuri mai detaliate ale clădirii pot fi adăugate. 

 

Un buton în partea superioară a ecranului numit Site Map permite navigarea înapoi la planul complet şi mărirea altor zone.  

 

Pentru a seta o legătură pe hartă, selectaţi  New Link/Zone din bara de instrumente superioară şi daţi clic în zona de pe hartă. De aici, 

zona poate fi configurată pentru a mări sau micşora atunci când este accesată. Selectaţi micşorare şi selectaţi harta pe care vreţi să o 

micşoraţi. 

 

Opţiuni legate de zone 
Alegeţi un număr de zonă din jumătatea inferioară a ferestrei. 

Sub detaliile de captură, introduceţi orice text şi alegeţi tipul de caractere şi modul de afişare pe care doriţi să îl afişaţi în interiorul zonei. 

 
Fereastra de umbre (Shading) permite umplerea zonei selectate cu culoare solidă sau dungată etc. 

 
Pot fi afişate margini în jurul zonei şi culoarea şi lăţimea acestora poate fi aleasă. 

 
Umplerea cu culoare a zonei (Fill Colouring) poate fi aleasă pentru a se potrivi cu fundalul în care zona este afişată. De exemplu o zonă 

roşie pe un fundal roşu nu va putea fi observată. 
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Culoarea de bază a zonei poate fi aleasă şi setată folosind paleta de culori. 
 
Culorile de umplere permit zonelor să fie afişate într-o varietate de moduri pentru a se potrivi cu fundalul pe care este desenată zona. 

 
După ce aţi setat proprietăţile zonei, apăsaţi OK pentru a desena zona pe hartă. 
Zona va fi arătată ca un pătrat cu patru mânere, care poate fi tras în orice direcţie pentru a-l mări, a-l face dreptunghiular sau 

trapezoidal. 
Pentru a crea zone cu mai mult de patru laturi, pot fi adăugate noduri adiţionale folosind butonul Add Nodes. Nodurile trebuie să fie 

adăugate între două mânere verzi. Apoi acestea pot fi trase în poziţia necesară. 
Daţi clic pe butonul Add Nodes pentru a opri adăugarea nodurilor când aţi terminat de adăugat. 

Adăugarea de noduri permite oricărui poligon să fie desenat cu un grad rezonabil de acurateţe. 

 
Cele opt iconiţe de instrumente de pe bara verticală pot fi folosite pentru a ajusta aria zonei în orice direcţie, pentru a realiza elementele 

fine ale desenului. 
Zona pe care tocmai am desenat-o va fi acum arătată în navigatorul de proiect în partea stângă sub harta pe care este desenată. 
Proprietăţile zonei (culoare, tip de umplere, etc) pot fi schimbate prin clic dreapta a unei zone din desen şi alegerea Zone Options. 

 
Test Map Link/ Testare legături hartă 
Legătura hărţii poate fi testată prin clic dreapta pe hartă şi selectarea Test Map Link. Pentru  a reveni înapoi la harta la care lucraţi, 

selectaţi-o din nou din navigatorul de proiect din ecranul din stânga. 
 

Transformations/ Transformări 
Ariile zonale care au fost desenate pot fi modificate prin clic dreapta şi selectarea Transformations din meniu. Acest lucru permite ariei 

zonale să fie plasată în faţa sau în spatele altor zone, sau să fie răsturnată orizontal sau vertical.  
 

Lock/ Blocare 
Zonele care sunt complete şi nu mai au nevoie de modificări, pot fi blocate împotriva editării ulterioare prin selectarea elementului Lock 

din meniul ce se deschide dând clic dreapta. Ele pot fi deblocate prin selectarea Unlock din acest meniu. 
 

Duplicate/ Duplicat 
Zonele care sunt de aceeaşi mărime şi formă pot fi reproduse foarte rapid prin desenarea uneia şi duplicarea acesteia prin clic dreapta 

şi selectarea cuvântului duplicate. Duplicatele pot fi modificate după necesitate prin clic dreapta asupra lor şi selectarea zone options. 
 
Delete/ Ştergere 
Zonele pot fi şterse prin selectarea lor şi apoi clic dreapta şi alegerea cuvântului Delete. 

 
Zone text/ Text zone 
Text pentru zone poate fi adăugat tuturor zonelor odată ce acestea au fost create, prin selectarea butonului Zone Text din bara de 

instrumente superioară. 
Textul pentru zonă este afişat lângă numărul zonei atunci când un eveniment se activează. 

 

 
3.3 Adăugarea de dispozitive pe hartă 
 

Navigatorul de reţea din partea stângă a ecranului arată toate panourile de control din reţeaua de alarmă de incendiu. Daţi clic pe  

semnul + de lângă panou pentru a mări vederea şi apoi clic pe semnul + de lângă Loops, Panel I/O sau I/O boards pentru a vedea 

dispozitivele individuale şi intrările/ ieşirile. 
 

Tabulatorul de plasare a zonei (Zone Placement) din partea inferioară a navigatorului de reţea va arăta toate dispozitivele sortate pe 

zone. 
Selectaţi această vedere pentru a adăuga dispozitive la zone. 
Pentru a adăuga un dispozitiv pe hartă, selectaţi vederea Zone Placement şi daţi clic pe semnul + de lângă numărul zonei care trebuie 

configurată. 
Acest lucru va arăta toate dispozitivele care au fost puse în acea zonă de către fişierul .lex. 
Pentru a plasa un dispozitiv, daţi clic pe el şi cu butonul de la mouse ţinut apăsat, trageţi-l în zona de poziţionare pe hartă, care este 

reprezentativă pentru locul unde este montat dispozitivul. 
Pentru a plasa mai multe dispozitive, ţineţi apăsată tasta CTRL sau Shift şi daţi clic pe mai multe dispozitive şi apoi trageţi-le pe hartă. 

 
Folosind cele patru iconiţe din partea de jos a barei verticale, unul sau mai multe dispozitive selectate (reprezentate printr-un chenar 

albastru şi selectate prin desenarea unei zone în jurul lor în timp ce ţineţi apăsată tasta CTRL) pot fi mutate în orice direcţie pentru a 

putea fi poziţionate cu mai multă acurateţe. Dând clic dreapta pe zonă, selectând opţiunile hărţii de fundal şi ajustând distanţa din 

dimensiunea grilei, se pot schimba dimensiunile acestora. 

 

Odată ce au fost plasate, iconiţele pot fi schimbate sau editate prin selectarea lor şi apoi clic dreapta pe ele. 
Selectând Icon Options din sub-meniu, permite iconiţelor să fie schimbate cu un alt tip sau să fie redimensionate cu ajutorul tabulatorului 

Device Details. Poate fi alocat, de asemenea, un mesaj specific, care va apărea după sufixul mesajului, aşa cum este descris mai jos. 

Aceasta permite ca mesaje specifice să poată fi adăugate pentru dispozitivele individuale în plus faţă de mesajele de evenimente 

standard.  

 

După plasare, dispozitivele vor fi arătate îngroşat în listă, indicând faptul că au fost plasate.  
Repetaţi această procedură pentru toate dispozitivele din toate zonele pe toate hărţile până când toate dispozitivele din navigatorul de 

reţea sunt arătate îngroşat. 
 

Când proiectarea a fost terminată, legăturile hărţilor ar trebui testate pentru a vă asigura că acestea lucrează în mod corect şi fişierele 

au fost salvate. 
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Mesaje 
 

Mesaje standard pentru evenimente 
GUIDE nu trebuie neapărat să afişeze hărţi sau planuri de etaje. Fiecare activare de eveniment are, de asemenea, o fereastră de 

mesaje care conţine tipul de eveniment, nodul, zona, bucla, adresa şi locaţia, ca standard. 
Text adiţional poate fi adăugat pentru fiecare tip de eveniment. Acesta poate include instrucţiuni de ce trebuie făcut atunci când intervine 

un eveniment particular, numere de telefon de contact sau orice altceva ce poate fi considerat potrivit pentru o instalaţie particularizată. 

 

Pentru a accesa fereastra de mesaje, daţi clic pe butonul Messages de pe bara de instrumente de sus. 
 

Partea stângă a ecranului permite selectarea tipului de eveniment. Antetul mesajului este format din tipul evenimentului, dar poate fi 

schimbat dacă se doreşte acest lucru. Tipul de caractere şi culoarea acestora poate fi de asemenea schimbată folosind ustensilele de 

formatare de bază a textului de pe bara de instrumente. 

 
Corpul mesajului este informaţia ce se primeşte de la panoul de control. Conţinutul acestuia nu poate fi schimbat dar, tipul de caracter, 

stilul şi culoarea pot fi schimbate prin selectarea butonului Set Font button din cadrul ferestrei corpului de mesaj. 
 

Sufixul mesajului este rezervat pentru informaţii adiţionale care ar putea fi necesare, cum ar fi instrucţiuni în caz de urgenţă. Tipul de 

caractere, stilul şi culoarea pot fi schimbate folosind instrumentul standard de formatare a textului de pe bara de sus. 
 

Mesaje specifice utilizator 
Acestea permit adăugarea de text adiţional care va apărea după sufixul mesajului. Când adăugaţi un mesaj specific, este de ajutor să 

numiţi mesajul cu aceeaşi adresă a dispozitivului, de ex. Nod 1, Bucla 2, adresa 12. 
Când alocaţi mesaje specifice utilizator (clic dreapta pe iconiţa dispozitivului>Icon Options>Event Message text) mesajul poate fi apoi 

căutat după adresa sa. 

 

 
3.4 Bara de instrumente principală 
 

Arrow/ Săgeată 
Instrumentul săgeată din partea stângă sus de pe bara principală de instrumente opreşte funcţionare butonului New Link/Zone şi 

setează cursorul de pe hartă ca o cruciuliţă (dacă nu se află deasupra unui nod de colţ). 

Acest lucru activează selecţia dispozitivelor, mişcarea şi editarea. 

 
New Link/Zone – Legătură/Zonă nouă 
Buton care, atunci când este apăsat, permite desenarea de noi zone şi legături a fi create pe hartă. 

 
Add Nodes/ Adăugare noduri 
Permite adăugarea de mânere adiţionale la formele de zone pentru a crea poligoane. Noduri adiţionale trebuie adăugate între două 

noduri verzi arătate pe forma selectată a zonei. 

 
Lock Objects/ Blocare obiecte 
Buton care previne ca dispozitivele care au fost plasate să mai fie mutate accidental. 
 

New Map/ Hartă nouă 
Permite unei hărţi noi să fie importate şi adăugate la navigatorul de proiect. 

 
Messages/ Mesaje 
Permite textului din antetul mesajului să fie schimbat faţă de cel original. Corpul de literă poate fi schimbat. 
Permite corpului de literă să fie schimbat în textul evenimentului ce este transmis de la panoul de control al incendiului. 
Permite adăugarea unui sufix cu orice tip de corp de literă. 
Mesajele specifice ale utilizatorului pot fi introduse aici, pentru ca dispozitivele selectate să poată afişa informaţii specifice atunci când 

sunt activate. 

 
Zone Text/ Text zonă 
Un mesaj text poate fi adăugat fiecărei zone. Acest lucru se va afişa în partea de sus a barei de mesaje când un eveniment este activat. 

 
User Icons/ Iconiţe utilizator 
Iconiţele disponibile au fost proiectate pentru a satisface necesităţile celor mai multe sisteme de incendiu şi iconiţele standard pentru 

orice dispozitiv pot fi schimbate prin clic dreapta şi selectarea Icon Option din meniu. 
Aceasta permite ca iconiţele din oficiu să fie schimbate cu oricare dintre iconiţele standard din listă, sau să fie re-dimensionate. 
Iconiţele pot fi de asemenea schimbate cu iconiţe ale clientului, care au fost create şi salvate anterior. 
Mesajele specifice utilizator pot fi de asemenea adăugate prin selectarea tabulatorului Event Message Text. Acestea sunt mesaje create 

anterior, aşa cum s-a precizat în paragraful  Messages, de mai sus. 
 
Save/ Salvare 
Salvează proiectul curent în locaţia specificată. 
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4.0 BMPGrabber 
 
Acesta este un program utilitar simplu care permite desenelor realizate în programe CAD in format .dxf sau .dwg să fie importate şi 

secţiuni ale acestor desene să fie mărite sau micşorate şi salvate în format .bmp pentru a fi folosite cu GUIDE Designer. 
 

Pentru a utiliza acest program utilitar, selectaţi Programs>GUIDE>BMPGrabber. 
 

Select File>Open.DXF/.DWG sau folosiţi fişierul şi lista de directoare. 
 

Localizaţi fişierul .dxf sau .dwg  care trebuie importat şi apăsaţi Open. 
 

Folosind butoanele din partea dreaptă jos a imaginii, întreaga imagine poate fi mărită sau micşorată folosind butoanele + şi -, sau 

secţiuni ale imaginii pot fi mărite folosind celelalte butoane. 
Selectaţi săgeata şi desenaţi în jurul secţiunii din desen care o vreţi mărită, ţinând apăsat butonul de la mouse. Această zonă va fi acum 

mărită. Pentru a readuce imaginea la dimensiunea iniţială, apăsaţi butonul cu pătrăţelul gri (resetare mărire sau micşorare). 
In acest fel, secţiuni ale unui desen CAD (o clădire dintr-un plan de locaţie) poate fi mărit şi creat ca imagine hartă.  

 
Odată ce secţiunea dorită a fost selectată, dimensiunea poate fi mărită, alegând Edit>Set Window Size. 
Culoarea de fundal a desenului poate fi schimbată prin apăsarea pe Edit>Background Colour. 
Grosimea liniilor desenului poate fi schimbată prin alegerea Edit>Thickness 1, Thickness 2 sau Thickness 3. 
Când imaginea apare după cum este cerut în programul GUIDE designer selectaţi File>Save Current View As .BMP Image. 

Daţi un nume corespunzător fişierului şi salvaţi-l într-o locaţie unde poate fi găsit cu uşurinţă mai târziu. 

 
Când imaginea este deschisă cu programul GUIDE Designer, va apărea la aceeaşi dimensiune şi proporţii cum era atunci când a fost 

salvată cu ajutorul BMP grabber. 

Dimensiunile şi proporţiile imaginii pot fi modificate din interiorul programului Designer prin clic dreapta pe hartă şi alegerea opţiunii 

Background Map Options. 

 


